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Detailed Agisoft Metashape Workshop Instructions

Depending on your hardware capabilities, this workshop could take an entire day or more. To
build this model, the authors used a Windows 10 machine with an AMD Ryzen 3900 CPU,
64GB RAM, one GeForce RTX 2080 8GB GPU, with Agisoft Metashape version 1.6.4. Total
modelling time took ~2 hours.

For the purpose of generating a 3D model using Agisoft Metashape, two datasets of photos are
provided for participant use in case they do not have photography equipment. The first dataset,
which is the subject of this workshop, consists of 72 jpeg photos of a Greek Cycladic figurine
replica.  The Greek Cycladic figurine was chosen because it only needs to be oriented on one
axis (that is, there is no data to capture on the bottom), requires minimal photos to model which
reduces processing time, and is a simple subject on which to learn. The second dataset
consists of 223 jpeg photos of a dinosaur pedal element (in this case, a Triceratops toe). This
specimen is for intermediate learners who want to learn to process an object captured on more
than one axis.  The same process should be repeated for the dinosaur pedal element (although
we did not use scale bars for that object so that step should be skipped).  Since the pedal
element has roughly three times as many photos as the Greek Cycladic figurine and is a more
complex object photographed on two axes, it will take longer to model.

All photographs were captured using a Canon EOS 5D Mark III camera and a 50mm prime lens
mounted on a tripod (see below). Photos were captured in aperture priority mode with an ISO of
200, f stop of 22, and shutter speed usually around 1/13 to 1/20 of a second. In addition, the
Foldio 360 25 inch lightbox and automated turntable were used capturing 24 images (or one
image per 15 degrees of rotation) per sequence with the remote IR camera trigger with a 3.5
second delay between photos (to allow for object rotation on the turntable).



Canon DSLR (EOS 5D Mark III) on tripod with Foldio 360 lightbox and turntable capturing dinosaur pedal
element.

The photography datasets are provided as zip archives and will need to be unpacked for use. A
free utility to unzip archives is 7zip which is available for free download at https://www.7-zip.org/
Most Windows and Mac OSX machines have native support to unzip archives as well.

Greek Cycladic Figurine photography dataset (for beginners):
https://doi.org/10.15786/16543554

https://www.7-zip.org/
https://doi.org/10.15786/16543554


Dinosaur Pedal Element photography dataset (for intermediate users):
https://doi.org/10.15786/16543605

Agisoft Metashape, although a proprietary software application, is a very powerful and
professional photogrammetry application. It is affordable at only $59 for the standard license for
academic institutions and even better, that’s a one-time purchase. The professional version is
substantially more money at $549 for academic institutions but does add the ability to use
calibrated targets in photogrammetry. If you are working with photogrammetry often and in a
professional capacity, the professional version is recommended, but for workshop purposes, it’s
not required. For our purposes, downloading the trial version is more than sufficient. To do this,
one must download Metashape here: https://www.agisoft.com/downloads/installer/ When first
opened, Metashape will ask you if you want a 30 day trial license for the Professional version.  If
you want to be able to save, export, and use calibrated targets, all of which are covered in this
workshop, select the 30 day trial.  Metashape can be operated in Demo mode without a trial
license, but you will not be able to save or export your work. As noted above in the materials
section, one must have a decent computer in order to operate Metashape, otherwise your
processing time could be very lengthy.

Note that throughout these steps, your results may differ from the examples below slightly. Don’t
get caught up in replicating exact values (especially in the gradual selection process) as it is not
necessary for generating good 3D point clouds, meshes, or models. Also, this workshop was
designed with the use of Agisoft Metashape version 1.6.4. Last, many recommendations in this
workshop are based on Cultural Heritage Imaging consultations and the United States Bureau
of Land Management’s best procedures (developed by Tom Noble in 2015 for Agisoft Photoscan
version 1.1) for photogrammetric 3D modelling.1

Step 1:  Create and save project file.
Once you have installed Metashape, the first step is to save your project file from the File Menu.
It is suggested that you save your work often as this is a heavy computational application; some
of these processes can take a considerable length of time; and, like anything, it can crash.

1 Recommendations are based on expert advice received from Cultural Heritage Imaging during a
weeklong photogrammetry training course. http://culturalheritageimaging.org/

https://doi.org/10.15786/16543605
https://www.agisoft.com/downloads/installer/


Step 1b: Familiarize yourself with Metashape interface

Like many other applications, Metashape has several windows/panes (Workspace, Reference,
and Photos) that can be organized and ordered to suit your personal preferences. Metashape



processes data in “chunks,” which are listed in the Workspace pane. It is within each chunk that
photos, scale bars, and other model components will eventually be listed.

The Reference pane is where scale bars are created and assigned to the model. In this view,
the Reference pane has been pinned below the Workspace. The default view is to have the
Workspace and Reference panes accessible via tabs at the bottom left of the Metashape
screen.



The Photos pane is where thumbnails of all of the photos associated with the project will be
displayed.

The large, gray area in the center of the window is the Model view. This is where the 3D model
will be displayed as you go through the different steps in the software.

At the top of your Metashape window are the file menus and tool bars. What each of the file
menus, tool bars, and buttons are used for will be covered in more detail below.



Step 2:  Add photos from the extracted zip archive of the Greek Cycladic figurine
provided.

This will add all photos in the folder to your project. There are two ways to add photos.  Method
1:  Workflow > Add Folder (use the “Single Cameras” option when prompted).  Navigate to
wherever your photos are located on your local machine.

Method 2: Right-click on your “Chunk 1,” select “Add,” and then select “Add Photos.”



Once you add photos, you should see thumbnails of all images within the Photos pane. Double
clicking on any photo will open it up in an individual photo tab (opens on top of Model window).
You can simply close this tab by clicking the red “X” if desired.

Step 3: Masking photographs

Masking photographs is one of the most time-consuming aspects of Metashape  Although this
step is not technically required, it is highly recommended as it will save you ample time in
subsequent steps by masking out areas in your photos that you do not want to be part of your
3D model. Masking “crops” areas of photographs and then Metashape only processes the
un-masked areas. For turn-table photos you should mask two to eight different images
depending on the complexity of the object and whether you have flipped the object over (as is
the case with the dinosaur pedal element). For the Greek Cycladic figurine, mask four photos:
one photo each from the four “cardinal” directions (North, East, South, and West).

To mask, first double click a photo to open it in the photo tab.  We will choose the front of the
Greek Cycladic figurine to start. Once the photo is open, select the dropdown menu that has a
dashed-square shape.

Within this menu are several options:

1. Rectangle Selection:  Used to select a rectangle area.
Can only create a rectangle/square.



2. Intelligent Scissors:  Used to create a polygon selection (very useful tool). Click to
create a vertex, and continue creating vertices around the object. You complete
the polygon by clicking your first vertex (or connecting to the first vertex).

3. Intelligent Paint: Works similar to the Magic Wand, but can be tricky to use.
4. Magic Wand:  Auto-selects large area by color. In the example below, I clicked on

the black background.



Once you have created a selection, then you need to tell Metashape how you want to create a
mask using that selection. In the tool bar are three sets of blue/transparent squares. These
represent: Add Selection, Subtract Selection, and Invert Selection.

Selecting Add Selection will add whatever area you have selected to your mask, and Subtract
Selection removes masks from areas. Invert Selection is important because you can take
selections (like the rectangle and Intelligent Scissors examples above) and invert the selection
to select everything outside of the selected area:

In most instances you need to use a combination of all of the selection tools and
Add/Subtract/Invert options to create a mask that excludes everything in the photograph except
the object you want to model:



Repeat this process for the left, right, and back sides of the Greek Cycladic Figurine to create
four masked photos.

Step 4: Align Photos.

After masking 4 photos you can begin the first step in the modeling workflow: Workflow -> Align
Photos.  Expand Chunk 1 and you should see 72 photos listed. Once there, you’re ready to
Align Photos. Workflow > Align Photos (this process could take up to two hours or as little as
twenty minutes once started depending upon your computer). A note to make in all of these
steps is that the progress bars and the time left indicated on the progress displays are often
very inaccurate, so don’t pay too much attention to them. However, the Align Photos process
could take a very long time (2+ hours) on some computers.

When prompted, set the following options:
Accuracy: High
Generic Preselection: Checked/Source
Under Advanced, leave the Key point limit at the default setting of 40,000 and the Tie point limit
at the default 4,000.  Also, make sure to set the “Apply masks to” menu to “Tie Points.”

Explanation of settings:  A setting of High processes the images at 100% resolution, Medium
down samples that resolution to 50%, and Low down samples to 25% of original resolution. The
setting of Highest actually up-samples the images by a factor of 4 and is generally not
recommended because it will increase the processing time and can introduce additional
inaccurate points into the point cloud. For purposes of practicing in a workshop setting, you can



lower the Accuracy setting to Low and decrease the Tie Point limit down to 20,000. You can
experiment with these settings as they are not gospel, just recommendations. Reducing these
settings will greatly reduce processing time which might be necessary in a time-limited
workshop or with lower powered computers. Checking Generic Preselection can also save
compute time, but in some cases can also result in some (or many) photos not aligning. In the
case of this particular dataset, checking Generic Preselection with an Accuracy setting of High
will save processing time while rendering a very good sparse cloud without any problems so it is
(in this case) not a problem. The settings above are recommended for the best results.

Key points and Tie points:  Both key points and tie points are photogrammetric terms used in
many software applications (i.e. they are not unique to Metashape). A key point (or keypoint
descriptor) is a feature that photogrammetric software identifies in photos (by using an algorithm
called SIFT, which stands for Scale-Invariant Feature Transform) of an object that it thinks is
unique either because of the geometric shape or the texture. When the software application
finds the same key point(s) in multiple (two or more) photographs, those become tie points. It
then uses these tie points to identify 3D camera locations and positions which allow it to build
the sparse point cloud. By raising or lowering those limits you are allowing the application to
identify more or fewer points. It’s possible to allow too few and it’s also possible to allow too
many.

After Step 4 has completed, you should see a sparse point cloud of the model, and you can look
to see if all 72 photos have aligned (they should). It will indicate (in the Workspace area) how
many aligned out of 72. If not all photos aligned, you can re-run the photo alignment process.



Also, you may toggle on/off the “Show Cameras” button (pointed out below by the red arrow) to
see where your cameras were aligned. You should see three distinct circuits of photos (three
rings with twenty-four photos in each ring) as seen below. If you see a set of photos that do not
appear to be oriented in circuits, you will need to re-run the Align Photos procedure as it will
negatively affect your sparse cloud, dense cloud, geometric mesh, and texture in subsequent
steps.



Step 5: Gradual Selection procedure and manual clean-up.

The objective of this multi-step operation is to optimize the camera alignment and remove points
which the program detected that are not accurate.  Removing those inaccurate points will
improve your model.

A. Manual Cleanup

Access the the selection tools from the tool bar. Select stray points outside of the model
(selected in pink) and delete these points (“X” from tool bar or Delete/Backspace key).
You can use Control key to add points to a current selection, or use the Shift key to
remove points from the current selection. We suggest the Free-Form Selection tool as it
will let you highlight an arbitrary area of points instead of a circle or rectangle. Whatever
selection tool you choose, be careful not to cut through your model when selecting
points.  Remember, this is a 3D point cloud so anything behind the points you select to
be deleted will also be selected and deleted. This process can be difficult with a small
monitor and it does require a discerning eye to find single points in space so take your
time, zoom in and out, and rotate the sparse cloud in all planes to find any outliers.  After
you are finished deleting points manually, save your work.



B. Once clearly stray points are deleted manually, navigate to the Model Tab, and
select Gradual Selection and Image Count.

The first step in Gradual Selection is to choose Image Count. One of the biggest sources
of error is when tie points only show up on two images. To remove these, select Image
Count from the Criterion menu, and then move the scroll bar to Level: 2 to select the
points that only show up in two images.



Delete these selected points (“X” button from toolbar, or delete/backspace), find the
“Optimize Tool” in the Reference pane (circled below in black) and then keep the default
settings generated by Metashape. Click OK.

C. Return to the Gradual Selection dropdown, but this time select Reconstruction
Uncertainty.



At this point, you will be prompted to select a level.  The lower the level, numerically, the
more points you will be removing. You can slide the level back and forth and watch to
see how many points are being selected in the lower corner of the Model pane.  Initially,
this will be a pretty high number. A level of 10 is ideal but it’s not always possible
because you may simply remove too many points. If the level is over 10, enter 10 into
the Level box. Delete the selected points, and then optimize again following the same
procedure as before.

D. Return to Gradual Selection dropdown, and select Projection Accuracy.

This time around the level we’ll select should be in the recommended 2-4 range. Once
again, keep an eye on how many points you’re selecting (a lower numeric level selects
more points). In this case, we’ll go with 4, delete the points using the X icon in the menu
bar, and then another camera optimization as before.

E. Return to Gradual Selection dropdown, and select Reprojection Error



In this step, we’re looking for an error rate of no more than 1. In our example the
Reprojection Error is less than 1, so we don’t have to do any additional steps (click
cancel to exit at this point). However, if you do have a Reprojection Error greater than 1,
enter 1 into the Level, hit OK, and delete the selected points. Once again Optimize
Alignment following the previous steps.

At this point in the process, you should have a clean sparse point cloud.

Step 6:  Build Dense Cloud.

After performing Gradual Selection, you are ready for the next major step in the workflow,
building a dense point cloud. Navigate to Workflow->Build Dense Cloud. For the time
constraints associated with this workshop select Medium Quality, but for objects you might be
building at your own institution you will want to select High. Change Depth Filtering to
Aggressive, and keep the Calculate point colors setting enabled. Once those are selected hit
OK.

Depth filtering is a setting that will remove more points at the Aggressive level and fewer at the
Mild level. If you have poor photos, Aggressive can be helpful but if not, Mild might work too.



Step 7:  Cleaning Dense Point Cloud.

After the dense cloud is constructed there will be stray points/noise around the object you are
modeling. The only way to prevent this noise from entering the final product is to trim these
points manually. Use the same selection tools as when you were trimming the sparse cloud. Be
extra careful not to delete portions of the model you don’t want to get rid of. Save the model
before you start cleaning the dense cloud.

Step 8: Build Mesh.

At this point, you should have a clean Dense Point Cloud and you can proceed to build your 3D
surface. This is called a Mesh, and what Metashape does is create thousands (or millions) of



triangles/faces between the points within the Dense Point Cloud. To Build Mesh:
Workflow->Build Mesh.

Under the Source Data menu, select Dense Cloud; Surface Type should always be Arbitrary 3D
(unless you’re using UAV data which we won’t be in this case). If you’re using the Dense Cloud
as the source data, Quality is not selectable. Face count will default to the same resolution as
the Dense Cloud, but you can increase this (from Medium to High) if desired. For this workshop
we will keep face count at Medium . Expand the Advanced menu and be sure Interpolation is
enabled and check the Calculate vertex colors box. Press OK.

Step 9: Clean Mesh (if necessary).

In some cases, your mesh may have some noise that need cleaning or trimming.  If this
happens, you will need to trim the noise off of the bottom of the model using the appropriate
selection tool and then deleting those portions. This is done the same way as manually deleting
points from the point cloud.  Be careful not to trim into your model, or you will introduce a hole
that the application will have to fill and it will detract from its veracity.

You can also use Tools->Mesh->Close Holes and/or Smooth to help clean the Mesh.



Step 10: Scale Model (if desired).

If you would like to be able to make three dimensional measurements on your 3D model (or to

place it in context of other physical objects), one of the of the necessary steps is to apply scale
using scale bars. In this example, we have two calibrated scale bars included in each
photograph. To add Scale, double click the first photograph to open it.

Right-click in the center of the target and select “Place Marker” and then “New Marker.” This will
create “Point 1”



In the same photograph right click in the center of the 2nd target and select “Place Marker” and
“New Marker.” This will create “Point 2”

Close the first photograph and open the 2nd photograph. Two red lines will be visible. Navigate
to the center of the first marker and right-click. Select “Place Marker” and then select “point 1.”
Do the same for “point 2.”

After adding the locations of point 1 and point 2 in at least two photographs, the locations of
those points across all the remaining photographs will be displayed like this:



Importantly, in at least one additional photograph, click the point icons and adjust them to be in
the center of the target. The icons will change from gray shapes to green flags. Do the same
steps for adding points 3 and 4 onto the other scale bar. After adding all points each photograph
should look like this:

The next step is to navigate to the Reference Pane. Select point 1 and point 2, right click, and
then “Create Scale Bar.” Do the same for points 3 and 4.



Once the two scale bars are created, enter in the distances hand written on each scale bar
(visible in the photographs) into the “Distance(m)” columns.  The scale bars we use here display
distances between points in meters.

After the distances are added for both scale bars, hit the double arrow symbol (next to
Optimization). This will update the scaling/referencing for the model. Your model is now scaled
to real-world units and can be measured!

Step 11:  Build Texture (if desired).

Once you have your mesh the way you want it, if you want to build texture (color) you will need
to run that process from the Workflow menu by selecting Build texture and simply keeping the
default values in every case.  If you don’t want texture, this step can be skipped and you may go
on to Step 12.



You should now have a textured and scaled final model that should look similar to the one
below.



Step 12:  Export (OBJ, STL, PLY options are most common)

This is the final step in the process. At this point, you should have a clean geometry (and
possibly texture) for your model in Metashape.

You can now export your 3D model in a number of 3D file formats. If you want to include the
geometry and the texture, you should export it as a .obj file which includes what is called a
materials file (an .mtl), a texture file (in this case, as a .jpeg), and a geometry file ( the .obj file).

To do this, go to the File menu and select Export > Export Model.

From here, you can choose from a number of 3D file formats, but the Wavefront obj format is
suggested for web delivery and download because it includes both geometry and texture. Give
your file an appropriate name and hit OK.



On the following screen, keep the defaults, but also enable the Vertex normals box and then hit
OK. Obviously you may change the comment field if you wish to do so.



Depending on where you chose to save your file, you’ll actually now have three files that make
up your 3D model; an obj file (which is your geometry/mesh file), an MTL (or materials file, much
like a manifest), and a .jpeg file which is your texture file. You can choose to export the texture
file in a different image format in the previous step, including JPEG, PNG, TIF, and EXR. All
three of these files are necessary to view your 3D model with texture in any other application as
well as for web delivery so it is suggested to bundle them in a single directory.

One could also choose to export their model as a .ply or an .stl, which are also both common 3D
file formats, but a .obj file is the most versatile format for web delivery if you want to include
texture and geometry.

Once you have it saved as an obj, you can open the file in a variety of open source 3D software
applications including Meshlab, Meshroom, Blender, Maya, and more. Bear in mind that the obj
file, once again, consists of the geometry (the obj file itself), the materials file (the mtl file), and
the texture file (in this case, a jpeg file). All three are necessary for a complete view of the 3D
object in a third party application.

This model of the Greek Cycladic figurine, as built in this process with Agisoft Metashape, is
available for download and inspection on Sketchfab as seen below.

Screenshot of Greek Cycladic figurine modeled using photogrammetry and Agisoft Metashape. Model
available for download and inspection at: https://skfb.ly/opH6O

Now that you’ve completed the processing for the figurine, if you have the time or desire to
process a much more complex object, repeat all of these steps (with the exception of adding

https://skfb.ly/opH6O


scale) with the dinosaur pedal element photography dataset.  The model of the dinosaur pedal
element, as built using this same process with Agisoft Metashape, is available for download and
inspection on Sketchfab as seen below.

Screenshot of dinosaur pedal element modeled using photogrammetry and Agisoft Metashape. Model
available for download and inspection at: https://skfb.ly/6Wyyy

https://skfb.ly/6Wyyy

